SCE Training Curriculum
Siemens Automation Cooperates with Education | 05/2017

TIA Portal Module 042-201
WinCC Advanced with
TP700 Comfort and SIMATIC S7-1500
Matching SCE trainer packages for these training curriculums

SIMATIC HMI Panels and WinCC Advanced Software
- **SIMATIC HMI TP700 COMFORT PANEL**
  Order no.: 6AV2133-4AF00-0AA0
- **SIMATIC HMI TP1500 COMFORT PANEL**
  Order no.: 6AV2133-4BF00-0AA0
- **SIMATIC HMI WinCC Advanced V14 SP1 - Classroom license for 6 users**
  Order no.: 6AV2102-0AA04-0AS5
- **SIMATIC HMI WinCC Advanced V14 SP1 - Upgrade license for 6 users**
  Order no.: 6AV2102-4AA04-0AS5
- **SIMATIC HMI WinCC Advanced V14 SP1 - Student license for 20 users**
  Order no.: 6AV2102-0AA04-0AS7

SIMATIC Controllers
- **SIMATIC ET 200SP Open Controller CPU 1515SP PC F and HMI RT SW**
  Order no.: 6ES7677-2FA41-4AB1
- **SIMATIC ET 200SP Distributed Controller CPU 1512SP F-1 PN Safety**
  Order no.: 6ES7512-1SK00-4AB2
- **SIMATIC CPU 1516F PN/DP Safety**
  Order no.: 6ES7516-3FN00-4AB2
- **SIMATIC S7 CPU 1516-3 PN/DP**
  Order no.: 6ES7516-3AN00-4AB3
- **SIMATIC CPU 1512C PN with Software and PM 1507**
  Order no.: 6ES7512-1CK00-4AB1
- **SIMATIC CPU 1512C PN with Software, PM 1507 and CP 1542-5 (PROFIBUS)**
  Order no.: 6ES7512-1CK00-4AB2
- **SIMATIC CPU 1512C PN with Software**
  Order no.: 6ES7512-1CK00-4AB6
- **SIMATIC CPU 1512C PN with Software and CP 1542-5 (PROFIBUS)**
  Order no.: 6ES7512-1CK00-4AB7

SIMATIC STEP 7 Software for Training
- **SIMATIC STEP 7 Professional V14 SP1 - Single license**
  Order no.: 6ES7822-1AA04-4YA5
- **SIMATIC STEP 7 Professional V14 SP1- Classroom license (up to 6 users)**
  Order no.: 6ES7822-1BA04-4YA5
- **SIMATIC STEP 7 Professional V14 SP1 - Upgrade license (up to 6 users)**
  Order no.: 6ES7822-1AA04-4YE5
- **SIMATIC STEP 7 Professional V14 SP1 - Student license (up to 20 users)**
  Order no.: 6ES7822-1AC04-4YA5

Please note that these trainer packages are replaced with successor packages when necessary. An overview of the currently available SCE packages is provided at: [siemens.com/sce/tp](http://siemens.com/sce/tp)

**Continued training**
For regional Siemens SCE continued training, please contact your regional SCE representative at [siemens.com/sce/contact](http://siemens.com/sce/contact)

**Additional information regarding SCE**
[siemens.com/sce](http://siemens.com/sce)
Information regarding use
The SCE training curriculum for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training purposes for public educational and R&D institutions. Siemens AG does not guarantee the contents.

This document is to be used only for initial training on Siemens products/systems. This means it can be copied in whole or part and provided to trainees for use within the scope of their training. Circulation or copying this training curriculum and sharing its content is permitted within public training and advanced training facilities for training purposes.

Exceptions require written consent from the Siemens AG Contact: Mr. Roland Scheuerer roland.scheuerer@siemens.com.

Offenders will be held liable. All rights including translation are reserved, particularly if a patent is granted or a utility model or design is registered.

Use for industrial customer courses is expressly prohibited. We do not consent to commercial use of the training curriculums.

We wish to thank the TU Dresden, especially Prof. Dr.-Ing. Leon Urbas, the Michael Dziallas Engineering Corporation and all other involved persons for their support during the preparation of this training curriculum.
Table of contents

1  Goal ................................................................................................................................. 6
2  Prerequisite...................................................................................................................... 6
3  Required hardware and software .................................................................................. 6
4  Theory .............................................................................................................................. 8
  4.1  Process visualization ................................................................................................. 8
  4.2  SIMATIC HMI Panel TP700 Comfort ...................................................................... 9
     4.2.1  Device description ............................................................................................... 9
     4.2.2  Memory concept .................................................................................................. 11
     4.2.3  Settings on the Touch Panel TP700 Comfort/Start Center ............................... 13
     4.2.4  Setting the date and time ................................................................................... 14
     4.2.5  Setting transfer properties and assigning the IP address ............................... 15
     4.2.6  Calibrating the touch panel and rebooting ...................................................... 17
  4.3  WinCC Advanced V13 programming software (TIA Portal V13) .......................... 19
     4.3.1  Project .................................................................................................................. 20
     4.3.2  Hardware configuration ...................................................................................... 20
     4.3.3  Schedule the hardware ...................................................................................... 21
     4.3.4  Planning the screen structure ............................................................................ 22
     4.3.5  Planning of the screen structure ...................................................................... 23
     4.3.6  Basic settings for WinCC Advanced in the TIA Portal ..................................... 24
     4.3.7  Resetting the SIMATIC HMI Panel TP700 Comfort and setting the IP address .. 25
     4.3.8  WinCC user interface ......................................................................................... 29
     4.3.9  Project tree .......................................................................................................... 30
     4.3.10 Details view ....................................................................................................... 30
      4.3.11  Menu bar and buttons ..................................................................................... 31
     4.3.12  Work area ......................................................................................................... 31
     4.3.13  Tools ................................................................................................................. 32
     4.3.14  Properties window ............................................................................................ 32
     4.3.15  Other tabs ......................................................................................................... 33
  5  Task ................................................................................................................................. 34
  6  PlanningProcess visualization .................................................................................... 34
     6.1  Program description for the sorting station with speed control and speed monitoring of the motor ......................................................................................................................... 35
     6.2  Technology diagram ............................................................................................... 37
     6.3  Reference list ........................................................................................................... 38
  7  Structured step-by-step instructions .......................................................................... 39
     7.1  Retrieving an existing project ................................................................................. 39
     7.2  Adding a SIMATIC HMI Panel TP700 Comfort .................................................... 40
     7.3  HMI wizard for the TP700 Comfort Panel ............................................................ 42
     7.4  Device configuration of the TP700 Comfort Panel ............................................... 47
7.4.1 Setting the IP address ................................................................. 48
7.5 Compiling the CPU and panel and saving the project .................. 49
7.6 Configuring the graphic display .................................................. 50
7.7 Displaying a process value in an IO field .................................... 55
7.8 Visualizing binary signals with animated rectangles .................... 58
7.9 Symbol library ........................................................................... 62
7.10 Connections and HMI tags .......................................................... 65
7.11 Downloading the CPU and panel ............................................... 67
7.12 Process visualization in the simulation ........................................ 71
7.13 Switches and buttons for the process operation ............................ 73
7.14 Adapting the headers in the template ......................................... 88
7.15 Bar graph ................................................................................ 101
7.16 Alarms ...................................................................................... 108
7.16.1 General alarm settings ............................................................ 108
7.16.2 Alarm window ...................................................................... 109
7.16.3 Alarm indicator ...................................................................... 111
7.16.4 Alarms for system diagnostics of CPU 1516F ................. 112
7.16.5 Alarm class settings ................................................................. 114
7.16.6 System events ...................................................................... 115
7.16.7 Controller alarms ................................................................. 115
7.16.8 Analog alarms ...................................................................... 116
7.16.9 Discrete alarms .................................................................... 117
7.17 Remote control of the TP700 Comfort Panel ......................... 123
7.17.1 Activating web services for Runtime ..................................... 123
7.17.2 WinCC Internet settings in the TP700 Comfort Panel .......... 123
7.17.3 Starting remote access to the TP700 Comfort Panel .......... 126
7.18 Archiving the project ................................................................. 128
8 Checklist ..................................................................................... 129
9 Exercise ...................................................................................... 130
9.1 Task – Exercise .......................................................................... 130
9.2 Technology diagram .................................................................. 130
9.3 Reference list ............................................................................ 131
9.4 Planning ................................................................................... 131
9.5 Checklist – Exercise ................................................................. 132
10 Additional information ............................................................... 133
PROCESS VISUALIZATION WITH THE SIMATIC HMI PANEL TP700 COMFORT AND WinCC ADVANCED

1 Goal

In this chapter, you will become acquainted with the basics of process visualization and the use of a SIMATIC HMI Panel TP700 Comfort together with the SIMATIC S7-1500 and the TIA Portal programming tool.

The module explains the configuring of a SIMATIC HMI Panel TP700 Comfort, the creating of the connection to the SIMATIC S7-1500 and the read and write access to CPU data from the SIMATIC HMI Panel TP700 Comfort.

The SIMATIC S7 controllers listed in Chapter 3 can be used.

2 Prerequisite

This chapter builds on the chapter "Global data blocks with SIMATIC S7 CPU 1516F-3 PN/DP". You can use the following project for this chapter, for example: "SCE_EN_032-600_Globale_Data_Blocks_R1508.zap13".

3 Required hardware and software

1 Engineering station: requirements include hardware and operating system (for additional information, see Readme on the TIA Portal Installation DVDs)

2 SIMATIC STEP 7 Professional software in TIA Portal – as of V13

3 WinCC Advanced software in TIA Portal – as of V13

4 SIMATIC S7-1500/S7-1200/S7-300 controller, e.g. CPU 1516F-3 PN/DP – Firmware as of V1.6 with memory card and 16DI/16DO and 2AI/1AO

   Note: The digital inputs and analog inputs and outputs should be fed out to a panel.

5 SIMATIC HMI Panel TP700 Comfort

6 Ethernet connection between engineering station and controller and between controller and TP700 Comfort control panel
1 Engineering station

2 SIMATIC STEP 7 Professional (TIA Portal) as of V13

3 WinCC Advanced (TIA Portal) as of V13

4 SIMATIC S7-1500 controller

5 SIMATIC HMI Panel TP700 Comfort

6 Ethernet connection

Control panel
4 Theory

4.1 Process visualization

Production processes are becoming more and more complex and greater demands are being placed on the functionality of machinery and plants. For this reason, the operator needs a high-performance tool to control and monitor production plants. An HMI (Human Machine Interface) system represents the interface between the human being (operator) and the process (machine/plant). The controller has the actual control over the process. There is therefore an interface between the operator and WinCC (on the HMI panel) and an interface between WinCC and the controller.

SIMATIC HMI Comfort Panels and WinCC undertake the following tasks:

- Representing processes with a clear screen structure
  The process is represented on the HMI device. If, for example, a state changes in the process, the display is updated on the HMI device. The process can be represented clearly structured on multiple screens.

- Operating processes
  The operator can operate the process using the graphical user interface. The operator can, for example, enter a setpoint for the controller or start a motor.

- Outputting alarms
  If critical process states occur in the process, an alarm is triggered automatically; for example, when a specified limit is exceeded.
• Logging process values and alarms
The HMI system can log alarms and process values. You can document the process history in this way. As a result, you still have access to older production data even at a later time.

• Documenting process values and alarms
The HMI system can print out alarms and process values as reports. For example, you can output the production data at the end of a shift.

• Managing process parameters and machine parameters in recipes
The HMI system can store parameters for processes and machines in recipes. You can transfer these parameters, for example, from the HMI device to the controller in a single step in order to change production to another product type.

• User management
Certain rights can be granted to the devices and the possible operator inputs can be limited for certain users.

4.2 SIMATIC HMI Panel TP700 Comfort

4.2.1 Device description
The SIMATIC HMI Comfort Panels product line includes touch panels (operated by a touch screen), key panels (operated by a keyboard) and key & touch panels (operated by a keyboard and touch screen).

The SIMATIC HMI Comfort Panels cover all requirements described in Chapter 3.1. The following is also optionally possible:

– Support for operation through help texts
– User-specific expansion of functionality through VBScript
– Microsoft Excel/Word/PDF Viewer for displaying documents
– Remote access to the user interface of the Comfort Panel via Ethernet from the web browser of another HMI device or any PC through the WinCC/Sm@rtServer option
– Recording of operations in an audit trail with electronic signature through the WinCC/Audit option
– Uninterruptible power supply (UPS) with USB support

This document explains these HMI devices using the TP700 Comfort as an example.

Figure 1: TP700 Comfort
The WinCC Advanced V13 (TIA Portal V13) software is required for configuration and programming. This software is included in the product package of the SCE Trainer Packet "SIMATIC HMI TP700 COMFORT PANEL".

**Notes:**

Because all devices in this series have similar functions, it would also be possible to work through the chapters of this document with a different device version in this series.

WinCC Advanced Runtime Simulation can also be used to represent the TP700 Touch Panel on the PC (included in the product package of the SCE Trainer Package SIMATIC HMI TP700 COMFORT PANEL).

**Front view of the TP700 Comfort**

![Front view of the TP700 Comfort]

1. Touchscreen display

**Rear view of the TP700 Comfort**

![Rear view of the TP700 Comfort]

1. Rating plate
2. Slots for SD memory cards
Interfaces of the TP700 Comfort

1. Connection for power supply
2. Connection for equipotential bonding (ground)
3. PROFIBUS (Sub-D RS422/485)
4. 2x USB type A
5. PROFINET (LAN), 10/100 Mbit, 2 ports
6. Audio Line IN/OUT
7. USB type Mini-B

4.2.2 Memory concept

The HMI devices can use the following types memory:
- Internal memory
- System memory card
- Memory card
- USB mass storage connected to the USB port

Internal memory
The following data is stored here:
- Operating system
- Project file
- License keys
- User management
- Recipes

**Note:** Cyclic write access is not permitted for the internal memory because this reduces the life expectancy of the internal memory and thus the service life of the HMI device. You should preferably use external memory cards, such as the SIMATIC HMI Memory Card, if possible, in order to prolong the service life of the HMI device for the storage of data records and for logs.
Memory card
The following data is stored here:
– Logs
– Backups
– Recipes
You can use commercially available memory cards in "SD(IO / HC)" or "MMC" format as the memory card. For reasons of data consistency, use of a SIMATIC HMI Memory Card as the memory card is recommended.

System memory card
The system memory card is part of the service concept of the HMI devices and helps to reduce downtimes.

When you activate the service concept, all data is transferred from the internal memory of the HMI device to the system memory card. In this way, if the HMI device fails, the system memory card can simply be inserted into the replacement device.

Only the SIMATIC HMI Memory Card with 2 GB or more memory is permitted as the system memory card. Other memory cards are not recognized by the HMI device as a system memory card.

Slots for memory card and system memory card

① Slot for memory card in "SD(IO / HC)" or "MMC" format
② Slot for system memory card
③ Locking slide
4.2.3 Settings on the Touch Panel TP700 Comfort/Start Center

A few important settings must be made directly on the Touch Panel TP700 Comfort.

The Touch Panel TP700 runs on the Windows CE operating system and can be operated, like all touch panels, directly on the screen. For better operation, you should use a touch pen or connect a mouse to the panel's USB port.

After the panel starts, the desktop containing the standard icons and the 'Start Center' window appear. The version of the images present on the panel is also displayed in this window.

Buttons in the Start Center:

- **Transfer**: The data transfer becomes activate (Connecting to host …) and the panel waits for the configuration data to download from WinCC Advanced to the PC.
- **Start**: Runtime is started and the process visualization appears on the panel. The panel is often set up so that the start occurs automatically after a few seconds.
- **Settings**: The Windows CE settings dialog opens. Settings for the panel can be made here.
- **Taskbar**: The Start bar of Windows CE opens.

→ Select → "Settings" in the "Start Center" directly after switching on the voltage supply and the start of the panel.

![Image of SIMATIC HMI Touch Panel]

**Note**: The selection of "Settings" must occur fast enough, and before the automatic "Start" of Runtime.
4.2.4 Setting the date and time

→ Select **Date/Time** from the icons in order to set the date and time.

→ Set the date, current time and time zone. → Close and confirm the dialog with "OK".
4.2.5 Setting transfer properties and assigning the IP address

→ Select the icon in order to open the transfer settings.

→ Select “Automatic”. The transfer will then be started from the WinCC Advanced software.

→ Select Ethernet “PN/IE” as the transfer channel. Press the “Properties...” button → to set the IP address on the panel and to make or check the network settings.

Notes:
To set the MPI or PROFIBUS address on the panel, select the MPI or PROFIBUS interface and then press the Properties button to make or check the bus settings.

The settings in the Transfer Settings window have nothing to do with the connection settings in the project. This means, for example, that data can be transferred between the TP700 panel and WinCC Advanced using the Ethernet interface, and communication between the panel and the SIMATIC S7 controller can take place via the PROFIBUS interface.

In our example, data is transferred between the TP700 panel and WinCC Advanced and communication takes place between the panel and the SIMATIC S7 controller via the Ethernet interface.
Double-click the Ethernet interface in the network settings to select it.

In the "IP Address" tab, select the "Specify an IP address" option and set the IP address and subnet mask. Close and confirm the dialog with "OK".

Click to close the network settings.

Click "OK" to accept the transfer settings.
4.2.6 Calibrating the touch panel and rebooting

→ Select the icon in order to open the basic settings of the touch panel.

→ Select the "Touch" tab → Start the calibration there with "Recalibrate".

→ Follow the instructions on the touch panel and press on the center of the target as accurately as possible.
To conclude the calibration operation, tap on the touch display of the panel again.

Now select the "Reboot" option in the "Device" tab.

Press the "Reboot" button.
4.3 WinCC Advanced V13 programming software (TIA Portal V13)

The WinCC Advanced V13 software (TIA Portal V13) is the programming tool for the following visualization systems:
- WinCC Runtime Advanced for PC-based single-user systems with licenses for 128, 512, 2k, 4k as well as 8k Power Tags (tags with a process interface)
- SIMATIC Comfort Panels
- SIMATIC Mobile Panels
- SIMATIC Multi Panels
- SIMATIC Panels of predecessor generations (Series 70, 170, 270)
- SIMATIC Basic Panels

With WinCC Advanced V13 you have the following functions for creating HMI (Human Machine Interface) systems:
- Configuration and parameter assignment of the hardware
- Specification of communication and creation of a connection to a PLC
- Creation and design of screens with hierarchical structure
- Creation of internal and external variables
- Creation of alarms and alarm views
- Creation of logs and display of logs in the form of trends and tables
- Creation of recipes and recipe views
- Creation and printing of reports
- Creation of user-defined functions with Visual Basic Scripting
- Testing, commissioning and servicing with operational/diagnostic functions
- Remote operation via the optional WinCC Smart Server
- Recording of operations in an audit trail with electronic signature through the WinCC/Audit option
- Documentation

Support is provided for all functions through detailed online help.
4.3.1 Project

To implement a solution for an automation and visualization task, you create a project in the TIA Portal. A project in the TIA Portal contains the configuration data for the configuration and networking of devices as well as the programs and the configuration of the visualization.

4.3.2 Hardware configuration

The hardware configuration contains the configuration of the devices consisting of the automation system hardware, the intelligent field devices and the visualization hardware, e.g. panels as HMI (Human Machine Interface) systems. The configuration of the networks specifies the communication between the various hardware components. The individual hardware components are inserted in the hardware configuration from catalogs.

The hardware of automation systems comprises controllers (CPUs) with signal modules for input and output signals (SMs) and communication and interface modules (CP, IM). Other power supply modules (PS) and power modules (PM) are also available for supplying the modules with energy.

The signal modules and intelligent field devices connect the input and output data of the process to be automated and visualized to the automation system.

The visualization, in turn, accesses the data in the automation system.

Figure 2: Example of hardware configuration with centralized and distributed structures and process visualization

The hardware configuration enables the downloading of automation and visualization solutions to the automation system and access to the connected signal modules by the controller.
4.3.3 Schedule the hardware

Before you can configure the hardware, you must plan it (hardware planning). In general, you begin by selecting which controllers are needed and how many. Next you select the communication modules and signal modules. The selection of signal modules is based on the number and type of inputs and outputs needed. As the final step, a power supply that ensures that the necessary power is supplied must be selected for each controller or field device.

The functionality required and the ambient conditions are of vital importance for planning the hardware configuration. For example, the temperature range in the application area sometimes limits the devices available for selection. Fail-safe operation might be another requirement, for example.

The TIA Selection Tool (automation technology → select TIA Selection Tool and follow the instructions) provides you support.

Notes:

- TIA Selection Tool requires Java.
- Online research: If more than one manual is available, you should look for the description "Device Manual", "Product Manual" or simply "Manual" (as opposed to "Function Manual", "List Manual", "System Manual", etc.) in order to find the device specifications.

Figure 2 (see above) shows an automation structure that contains both centralized and distributed structures.

Centralized and distributed uses are also possible for the visualization. Panels are often used for distributed local operation. These can communicate with the controller via Ethernet, WLAN or fieldbus. For centralized operation and monitoring, PCs can also be used. They are usually connected to the controller via Ethernet.

The TIA Selection Tool (automation technology → select TIA Selection Tool and follow the instructions, requires Java) also supports you when selecting the panels.
4.3.4 Planning the screen structure

After selection of a device for the visualization, the screen structure must be planned. For this purpose, you should collect, group and structure the information to be displayed. A screen structure, such as shown by way of example in Figure 3, should be derived from this. The point of entry into the screen structure is always guaranteed by a so-called root screen.

![Screen Structure Diagram](image)

Figure 3: Example of the screen structure

The screen structure should be chosen to optimally support navigation by the user through the information distributed among the screens for operation and monitoring of the process.

The following questions can aid you in this:

*Which mental model of the process should be observed for the information display?*

*Which data belong together?*

*Which data belong in which order?*

*Which data belong to which actions/processes?*

*Is there cross-action data and the like?*

*Which data are key data, which are supplementary data?*
4.3.5 Planning of the screen structure

Every individual screen must be planned. For the information display, its use by people must also be considered. It is helpful here to observe design principles such as the law of proximity, law of similarity and law of symmetry. The following rules of thumb derived from the design principles can also aid in structuring screens:

→ Form groups of data blocks

→ Uniform division of the overall screen into work information, status or system information and controller information

→ Observe the average distribution of attention on the screen as a function of reading direction.

→ Use alignment as a design principle (align numbers, column headings same as column content)

→ Make effective use of a maximum of 30 – 40% of the available space: place as little information as possible and as much as necessary

→ Use codings sparingly (for example, color, bold text, brightness, shape, outline, pattern, flashing)

→ Subdivide numbers: Subdivide numbers with more than 4 digits in groups of 2, 3 or 4 (for example, 66 234)

→ Select numbers preferentially when listing objects, properties, etc.

→ Use and position designations uniformly, use short words if possible
4.3.6 Basic settings for WinCC Advanced in the TIA Portal

Users can specify their own default settings for certain settings in the TIA Portal. The path to the settings for the visualization is shown here.

→ In the project view, select the → "Options" menu and then → "Settings".

→ Under → "Visualization" in "Settings", select the desired default settings for the appearance of the user interface.

*Note:* Keep the default settings for the visualization here.
4.3.7 Resetting the SIMATIC HMI Panel TP700 Comfort and setting the IP address

The SIMATIC HMI Panel TP700 Comfort can be reset directly in the TIA Portal. A new IP address can also be assigned to the panel here.

To do so, select the Totally Integrated Automation Portal, which is opened here with a double-click.

(→ TIA Portal V13)

→ Then, select →"Online & Diagnostics" and open →"Project View".
→ In the project tree, select the network adapter of your computer under → "Online access". If you click → "Update accessible devices" here, you will see the IP address (if previously set) or the MAC address (if IP address not yet assigned) of the connected SIMATIC HMI Comfort Panel → Select → "Online & Diagnostics" here.
→ To reset the panel, select the "Reset to factory settings" function and click "Reset".

**Note:** For resetting to factory settings, "Runtime" should not yet be started in the panel and the "Start Center" should be displayed.

→ Confirm the prompt asking if you really want to reset the module with "Yes".
Before you can assign the IP address, you must wait until the panel has finished resetting. Afterwards, you must select → "Update accessible devices" and → "Online & diagnostics" of your panel again. To assign the IP address, select the → "Assign IP address" function here. Enter the following IP address here, for example: → IP address: 192.168.0.10 → Subnet mask 255.255.255.0. Click → "Assign IP address" and this new address will be assigned to your SIMATIC HMI Panel TP700 Comfort.

If the IP address was not successfully assigned, you will receive a message in the → "Info" window under → "General".

Note: The IP address of the SIMATIC HMI Panel TP700 Comfort can also be set using the Windows CE operating system of the panel.
4.3.8 **WinCC user interface**

- Project tree
- Menu bar and buttons
- Work area
- Tools
- Details view
- Properties window
4.3.9 Project tree

The project tree window is the central control point for project editing. All components and all available editors of a project are displayed in a tree structure in the project window and can be opened there.

Each editor is assigned a symbol that enables you to identify the associated objects. Only elements supported by the selected HMI device are displayed in the project window.

You can access the HMI device settings in the project window.

4.3.10 Details view

The details view displays the contents or additional information on the objects selected in the project tree.
4.3.11 Menu bar and buttons

In the menus and toolbars, you will find frequently used functions you need to configure your HMI device. If a corresponding editor is active, editor-specific menu commands and toolbars are displayed.

If you point to a command with the mouse, a corresponding tooltip is provided for each function.

4.3.12 Work area

You edit the objects of the project in the work area. All other WinCC elements are arranged around the working area.

In the work area, you edit the project data either in tabular form (for example, tags), or graphically (for example, process screens).

A toolbar is located in the upper part of the work area. Here, you can select, for example, the font, font color and functions such as rotate, align, etc.
4.3.13 Tools

The Tools window contains a selection of objects is provided that you can insert into your screens, such as graphic objects and operator controls. In addition, the Tools window contains graphics with preassembled graphic objects and collections of faceplates.

Objects are moved to the working area via "drag and drop".

4.3.14 Properties window

In the properties window, you edit the properties of the objects selected in the work area (e.g. the color of screen objects). The window is available only in certain editors.

The properties of the selected object are displayed arranged by category in the properties window. As soon as you exit an input field, the value changes take effect. If you enter an invalid value, it is highlighted in color. The tool tip gives you information about the valid value range, for example.
In addition, animations (e.g. change of color at a signal state change in the PLC) and events (e.g. change of screen when a button is released) are configured for a selected object in the properties window.

### 4.3.15 Other tabs

Settings for the work area such as the level selection and grid functions can be made in the layout window.

Animations, instructions, tasks and libraries of the select object can be selected using additional tabs.
5 Task

In this chapter, process visualization will be added to the program from chapter "SCE_EN_032-600_Global_Data_Blocks". This will enable you to better monitor the process flow and operate the process more effectively.

6 Planning

Process visualization

A Touch Panel TP700 Comfort is to be used for the process visualization.

The programming device, a SIMATIC S7-1500 controller and the Touch Panel TP700 Comfort are interconnected via the Ethernet interface.

The basic configuration is to be performed using the wizard in the TIA Portal V13. All system screens are to be created in the process.

In an overview screen "Overview of sorting station", the process will be represented by the conveyor and sensors. Conveyor speed and the count of plastic workpieces will also be displayed here.

In this screen, it is also to be possible to select the operating mode, start and stop in automatic mode and reset the counter.

The actual speed of the motor will be graphically displayed in another screen titled "Motor Speed". The setpoint speed can also be specified here.

The "Plastic Magazine" will be created in a first step.

An alarm line, date/time and the plant states "Emergency Stop ok/triggered", "Main switch ON/OFF" and "Automatic started/stopped" are to be displayed in the header of all screens.

The footer contains a button that can be used to return to the start screen and a button to exit Runtime.

The alarm system is also to be configured.

System events are to be displayed on the panel and the CPU and limit violations of the motor speed and the main switch monitored.

The alarms will be displayed in the alarm line of the header and shown automatically in alarm windows when errors/warnings occur.

Remote control of the Touch Panel TP700 Comfort is activated via the web server.
6.1 Program description for the sorting station with speed control and speed monitoring of the motor

The "MOTOR_AUTO" [FB1] function block controls a conveyor in automatic mode.

The Memory_automatic_start_stop is latched with the Start_command but only if the reset conditions are not present.

The Memory_automatic_start_stop is to be reset if a Stop_command is pending or safety shutoff is active or automatic mode is not activated from the visualization.

The Conveyor_motor_automatic_mode output is activated when Memory_automatic_start_stop is set, the enable conditions are met and Memory_conveyor_start_stop is set.

To save energy, the conveyor should only run when a part is present. For this reason, the Memory_conveyor_start_stop is set when Sensor_chute_occupied signals a part and reset when Sensor_end_of_conveyor produces a negative edge or safety shutoff is active or automatic mode is not activated (manual mode).

Because the Sensor_end_of_conveyor is not able to be mounted directly at the end of the conveyor, signal stretching of the Sensor_end_of_conveyor signal is programmed.

The magazine for plastic holds only five parts. For this reason, the parts will be counted at the end of the conveyor. When the magazine contains five parts, automatic mode is to be stopped. After the magazine has been emptied, automatic mode will be restarted with the Start_command once the counter has been reset from the visualization.

The speed setting is made at an input of the "SPEED_MOTORCONTROL" [FC10] function in revolutions per minute (range: +/- 50 rpm).

First, the function first checks for correct entry of the speed setpoint in the range +/- 50 rpm.

If the speed setpoint is outside the range +/- 50 rpm, the value 0 will be output at the speed manipulated value output. The return value of the function (Ret_Val) will be assigned the value TRUE (1).

If the speed setting is within the range +/- 50 rpm, this value will first be normalized to the range 0…1 and then scaled to +/- 27648 with data type 16-bit integer (Int) for output as the speed manipulated value at the analog output.
In the "SPEED_MOTORMONITORING" [FC11] function, the actual value will be made available to B8 as an analog value and queried at an input of the "SPEED_MOTORMONITORING" [FC11] function.

The actual speed value will be scaled to revolutions per minute (range: +/- 50 rpm) and made available at an output.

The following four limits can be specified for the block inputs in order to monitor them in the function:

- Speed > SPEED_MOTOR_monitoring_error_max
- Speed > SPEED_MOTOR_monitoring_warning_max
- Speed < SPEED_MOTOR_monitoring_warning_min
- Speed < SPEED_MOTOR_monitoring_error_min

If a high or low limit is violated, the value TRUE (1) is assigned to the corresponding output bit.

If a fault is present, the protective tripping of the "MOTOR_AUTO" [FB1] function block is to be tripped.

The speed setpoint and the actual speed value as well as the positive and negative error and warning limits are created in the data block "SPEED_MOTOR" [DB2], as are the error and warning bits.

The setpoint and actual value of the counter for the plastic parts will be specified and displayed in the global data block "MAGAZINE_PLASTIC" [DB3]. These values are interconnected with the "MOTOR_AUTO" [FB1] function block using an input for the setpoint setting and an output for the actual value display.
6.2 Technology diagram

Here, you see the technology diagram of the plant for the task.

Figure 4: Technology diagram

Figure 5: Control panel
### 6.3 Reference list

The following signals are required as global operands for this task.

<table>
<thead>
<tr>
<th>DI</th>
<th>Type</th>
<th>Identifier</th>
<th>Function</th>
<th>NC/NO</th>
</tr>
</thead>
<tbody>
<tr>
<td>I 0.0</td>
<td>BOOL</td>
<td>-A1</td>
<td>Return signal emergency stop OK</td>
<td>NC</td>
</tr>
<tr>
<td>I 0.1</td>
<td>BOOL</td>
<td>-K0</td>
<td>Main switch &quot;ON&quot;</td>
<td>NO</td>
</tr>
<tr>
<td>I 0.2</td>
<td>BOOL</td>
<td>-S0</td>
<td>Mode selector manual (0)/ automatic (1)</td>
<td>Manual = 0 Auto = 1</td>
</tr>
<tr>
<td>I 0.3</td>
<td>BOOL</td>
<td>-S1</td>
<td>Pushbutton &quot;Automatic Start&quot;</td>
<td>NO</td>
</tr>
<tr>
<td>I 0.4</td>
<td>BOOL</td>
<td>-S2</td>
<td>Pushbutton &quot;Automatic Stop&quot;</td>
<td>NC</td>
</tr>
<tr>
<td>I 0.5</td>
<td>BOOL</td>
<td>-B1</td>
<td>Sensor cylinder -M4 retracted</td>
<td>NO</td>
</tr>
<tr>
<td>I 1.0</td>
<td>BOOL</td>
<td>-B4</td>
<td>Sensor part at slide</td>
<td>NO</td>
</tr>
<tr>
<td>I 1.3</td>
<td>BOOL</td>
<td>-B7</td>
<td>Sensor part at end of conveyor</td>
<td>NO</td>
</tr>
<tr>
<td>IW64</td>
<td>BOOL</td>
<td>-B8</td>
<td>Sensor actual value speed of the motor +/-10V corresponds to +/- 50 rpm</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DO</th>
<th>Type</th>
<th>Identifier</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q 0.2</td>
<td>BOOL</td>
<td>-Q3</td>
<td>Conveyor motor M1 variable speed</td>
</tr>
<tr>
<td>QW 64</td>
<td>BOOL</td>
<td>-U1</td>
<td>Manipulated value speed of the motor in two directions +/-10V corresponds to +/-50 rpm</td>
</tr>
</tbody>
</table>

**Legend for reference list**

- **DI** Digital input
- **AI** Analog input
- **I** Input
- **DO** Digital output
- **AO** Analog output
- **O** Output
- **NC** Normally Closed
- **NO** NO Normally Open
7 Structured step-by-step instructions

You can find instructions on how to carry out planning below. If you already have a good understanding of everything, it will be sufficient to focus on the numbered steps. Otherwise, follow the individual instructions in the steps below.

7.1 Retrieving an existing project

→ Before you can expand the "SCE_EN_032-600_Global_Data_Blocks_R1508.zap13" project from chapter "SCE_EN_032-600_Global_Data_Blocks", you must retrieve this project from the archive. To retrieve an existing project that has been archived, you must select the relevant archive with → Project → Retrieve in the project view. Confirm your selection with "Open".

( → Project → Retrieve → Select a .zap archive ... → Open)

→ The next step is to select the target directory where the retrieved project will be stored. Confirm your selection with "OK".

( → Target directory ... → OK)
7.2 Adding a SIMATIC HMI Panel TP700 Comfort

→ To create a new panel in the project, go to the portal view. In the portal, select the menu command → "Devices & networks" and → "Add new device".
Now, select the device version as follows: → "HMI" → "SIMATIC Comfort Panel" → "7" Display → "TP700 Comfort" and the correct order number of your panel, here, for example, → 6AV2 124-0GC01-0AX0

Enter "Panel TP700 Comfort" as the device name and → select the check box "Start device wizard". Click the [Add] button here.
7.3 HMI wizard for the TP700 Comfort Panel

The TIA Portal now creates the desired panel and automatically starts the HMI wizard for the TP700 Comfort Panel. This helps in specifying a few basic settings for the panel.

→ A prompt for the PLC connections appears first. Choose your previously configured CPU 1516F as the communication partner.

→ In order to connect your panel to the CPU, select the "Ethernet" interface. Confirm your selection by clicking "Next >>".
→ Under "Screen layout" you can change the default background color of your panel. 
→ Select the "Page header" check box with screen title, "Date/time" and "Logo". 
→ Confirm your selection by clicking "Next >>".

→ In the "Alarms" section, you can specify the alarms that are to be displayed in a window. 
→ Select all 3 alarm types (with the option “Top alarm line" for unacknowledged alarms). 
→ Confirm your selection by clicking "Next >>".
The "Screen navigation" section shows the screen structure with the screen names of the last created project, in which the start screen is the first screen shown on the left.

By clicking a screen name, you can easily assign a new name. By clicking the plus symbol, you can insert new pictures in the hierarchy. By clicking the delete symbol, you can delete selected screens.

Use this method to create the screen structure shown below with the corresponding screen names. Confirm your selection by clicking "Next >>".
In the "System screens" section, you can select previously preset views for system functions and automatically insert them. Enable all system screens with "Select all". Confirm your selection by clicking "Next >>".
In the "System buttons" section, you will find the four freely selectable buttons for Exit (Runtime), Log on, Language and Start screen. You can place these buttons on the provided button areas "Left", "Bottom" or "Right" using drag-and-drop.

Enable only the "Button area" "Bottom". Insert the button for the "Start screen" on the left and the button for Runtime "Exit" on the right. Confirm your selection by clicking "Finish".
7.4 Device configuration of the TP700 Comfort Panel

- The TIA Portal now switches automatically to the project view and displays the start screen of our visualization there.

- In order to configure our panel, select “Panel TP700 Comfort” in the project tree and double-click it to open its “Device configuration”.

![Image of TIA Portal with TP700 Comfort Panel configuration screen]
7.4.1 Setting the IP address

→ Double-click the Ethernet interface of the panel in the Device view.

→ In the "Properties" under General, open the "PROFINET interface [X1]" menu command and select the "Ethernet addresses" entry there.

→ Set the IP address 192.168.0.10 under IP protocol.

Note: The subnet mask was previously set in the settings of the CPU 1516F and is applied automatically to the panel.

→ To obtain an overview of the assigned addresses within a project, you can click the "Network view" icon in the "Network view". If you click the "Connections", the "HMI connection" between the CPU and panel that you previously created in the wizard will be displayed.
7.5 Compiling the CPU and panel and saving the project

To compile all blocks, click the "CPU_1516F" folder and select the icon for compiling in the menu. To compile the panel, click the "Panel TP700 Comfort" folder and select the icon for compiling in the menu. You can save your project by clicking the button in the menu.

(→ CPU_1516F → Panel TP700 Comfort →)

The 'Info' area then indicates whether compiling was successful or whether warnings or errors occurred.
7.6 Configuring the graphic display

→ After successful compilation, you want to lay out the first screen for the visualization. To do this, first open the → “Overview of sorting system” screen by double-clicking it.

→ Many objects such as the screen change buttons were already created by the wizard. The text filed in the center of the screen is to be removed by right-clicking it and selecting → "Delete" in the displayed dialog.
→ From Tools, select → "Graphic display" under → "Basic objects". The mouse pointer changes so that you can now draw an area for displaying a graphic in the work area.
You can double-click the graphic display area to have its properties displayed. Select the "Create graphic from file" icon in the "General" sub-item.

**Note:** There are four sub-items for the properties of the objects.

- Properties for static settings of the object.
- Animation for dynamic settings of the object.
- Events if actions are to be triggered from objects.
- Texts for the multilingual display within an object.
In the displayed dialog, select the "Foerderband_Conveyor.bmp" file in the "SCE_EN_042-201_Screens" folder and click → "Open"

**Note:** You can draw the graphics used in this document yourself and save them in *.bmp format or download them from [www.siemens.en/sce/S7-1500](http://www.siemens.en/sce/S7-1500) in the "SCE_EN_042-201 WinCC Advanced with TP700 and S7-1500" under "SCE_EN_042-201_Screens".

Select the "Foerderband_Conveyor.bmp" graphic for the display and click → "Apply".

**Note:** The generated graphic is stored in the "Languages & Resources" path under "Project graphics".
Position the graphic with the mouse in such a way that the positions and sizes shown below are entered under "Layout" in the properties. Select the "Fit graphic to object size" option to adapt the size.
7.7 Displaying a process value in an IO field

You first want to insert a display of the actual value of the current speed below the conveyor motor. To do this, select the "Program blocks" of the "CPU_1516F" and the "SPEED_MOTOR[DB2]" data block there. Then drag the "Actual speed value" tag from the "Detail view" to our "Overview of sorting station" screen.
The connection to the tag in the PLC has already been created in the "Properties" of the IO field under "General", "Process". The "Display format" is set to "Decimal". Now, all you have to do is change the "Format pattern" to → "s999.99" and the "Type" of the field to → "Output".

Note: The format pattern s999.99 means that the display will include three places in front of the decimal point two places after the decimal point and a sign.

In the "Properties" under "Appearance", we change the "Color" of the "Background" to → "Blue".
→ Under "Text format" in "Properties", change the "Horizontal" setting of "Alignment" to "Right".

→ Under "Layout" in the "Properties", change "Position & Size" as illustrated here so that the IO field will be displayed below the conveyor motor.

→ For the description, use drag-and-drop to insert a "Text field" before and after the IO field from "Basic objects" in "Tools". Type "Actual speed value" and "rpm" there.
→ Next, select the three objects → IO field → text field "Actual speed value" → and text field "rpm" in that order and then click on the → "Align selected objects on top" function in the toolbar of the work area. Save your project by clicking ![Save project button].

7.8 Visualizing binary signals with animated rectangles

→ For the visualization of the sensors, you want to start with sensor "-B4" at the slide. To allow you to draw and position the rectangle better, first change the zoom factor to → "300%".
→ Next, use "drag-and-drop" to move a rectangle from "Basic objects" in Tools to the position of sensor "B4".

→ Draw the correctly sized and positioned rectangle with the mouse or set the "Position & Size" under "Layout" in "Properties" as shown here. The sensor will then be displayed below the designation "B4".

→ In "Properties" under "Appearance", change the "Color" of the "Background" to "Gray" and the "Width" of the "Border" to "0".
→ Now change to the "Animation" tab and select "Display" and click "Add new animation".

→ In the displayed dialog, select "Appearance" and click "OK".

→ To establish the connection to the global tag in the CPU, select "PLC tags" under "CPU_1516F" and below that the "Tag_table_sorting_station". Next, drag the "-B4" tag from the "Detail view" to the "Name" field for the "Tag".
→ In the "Appearance" of the "Display", add an area with the value → "1" (signal state "High") and change the "Background color" to → "Green".

As shown in the previous steps, create a display for each of the following sensors:

→ "-B1", → "-B2", → "-B5", → "-B6" and → "-B7".

→ Also insert an additional binary display below the motor M1 and connect it to the global tag → "-B3". For the description, insert a text field → “-B3 Motor active" in front of it.
7.9 Symbol library

→ In order to show that the conveyor is being controlled, use drag-and-drop to move the "Symbol library" object from "Elements" in Tools onto the conveyor.

→ The symbol library contains a number of simple and more complex graphic elements. Under "General" in "Properties", select the "Category" → "Arrow". Select an arrow pointing in the opposing direction here → .
→ Under "Appearance" in "Properties", change the "Style" of the arrow to "Solid" and the "Color" of the "Foreground" to "Green".

→ Now change to the "Animation" tab and select "Display" and click "Add new animation".

→ In the displayed dialog, select "Visibility" and click "OK".
→ To establish the connection to the global tag in the CPU, select → "PLC tags" under → "CPU_1516F" and below that → "Tag_table_sorting_station". Next, drag the "Q3" tag from the → "Detail view" to inside the "Tag" field. In addition, select → "Single bit" as the type of evaluation.

→ Next, duplicate the arrow from the symbol library with all its properties using → "Copy" and → "Paste".
7.10 Connections and HMI tags

Before you download the configuration to the TP700 Comfort Panel, you should check the connection to the CPU 1516F. To do so, double-click “Connections” in “Panel TP700 Comfort” to select it. In the displayed view, you can check the IP addresses and the connection settings. It is important that the check box for Online is selected.

Note: If access protection has been activated for the CPU 1516F, the access password for the panel can also be entered here.

To access the HMI tags, you must double-click the “Default tag table” in the “HMI tags” folder in “Panel TP700 Comfort” to open it. All tags created by drag-and-drop have been entered here.
In the default tag table, you can check which tags in the CPU 1516F will be accessed. You can also make additional settings.

The "Acquisition cycle" of our tags is to be accelerated from 1 second to 100 milliseconds here. To do so, click the selection field and select a new acquisition cycle "100 ms" by double-clicking it.

You can make the settings of other tags using the "Autocomplete" function by selecting the lower right corner of the first entry with the mouse and dragging over the other entries.
7.11 Downloading the CPU and panel

→ Before the project is downloaded to the CPU and the panel, compile the CPU and panel again and save the project.

(→ CPU_1516F → \[\text{CPU} \] → Panel TP700 Comfort → \[\text{Panel} \] → Save project)

→ After successful compilation, the complete controller with the created program including the hardware configuration can be downloaded, as described in the previous modules.

(→ \[\text{Download} \])
To download the visualization to the panel, proceed in a similar way. Select the "Panel TP700 Comfort [TP700 Comfort]" folder and click the icon "Download to device".

![Image of panel TP700 Comfort with visualization]
The manager for configuring the connection properties (extended download) opens. First, the interface must be correctly selected. This happens in three steps.

- Type of the PG/PC interface → PN/IE
- PG/PC interface → here, for example: Intel(R) Ethernet Connection I217-LM
- Connection to interface/subnet → "PN/IE_1"

The "Show all compatible devices" check box must then be selected. The search for devices in the network is started by clicking the **Start search** button.
If your panel is shown in the "Compatible devices in target subnet" list, it must be selected and the download started.

(Panel TP700 Comfort → "Download")

You first obtain a preview. Confirm the prompt → "Overwrite all" and continue with → "Load".

Note: The ✅ symbol should be visible in every line of the "Load preview". You can find additional information in the "Message" column.
### 7.12 Process visualization in the simulation

For a connection to be set up between the runtime simulation on the PG/PC and the S7-1500 CPU, first the PG/PC interface has to be set to TCP/IP.

<table>
<thead>
<tr>
<th>No.</th>
<th>Procedure:</th>
</tr>
</thead>
</table>
| 1   | Open the Control Panel  
|     |   - with "Start > Control Panel"  
|     |     (Start menu for easy access to programs under Windows XP),  
|     |     - or via "Start > Settings > Control Panel"  
|     |     (with class Start menu as is the case in previous Windows versions). |
| 2   | In the Control Panel, double-click the icon "Set PG/PC Interface". |
| 3   | Set the following parameters in the "Access Path" tab:  
|     |   1. For the access point of the application, select "S7ONLINE [STEP 7]"  
|     |     from the drop-down list.  
|     |   2. From the list of interface parameter assignment used, select the  
|     |     interface "TCP/IP(Auto) -> with your network adapter that is connected  
|     |     directly with the Panel and the controller, e.g., 3Com EtherLink XL.  
|     |   3. Then click OK and confirm the next message with OK.  

![Set PG/PC Interface](image_url)
→ Select “Panel TP700 Comfort” and click the
→ "Start simulation" button.

→ The process visualization will be implemented completely on the PC with a connection to
→ the process data in the CPU 1516F. To close the simulation, you can select the
→ button for "Exit Runtime" in the application or simply close the window by clicking
→ "X".
7.13 Switches and buttons for the process operation

To have an interface to the process operation available in the PLC, select “Add new block” in the “Program blocks” folder in “CPU_1516F” and create a global data block “OPERATION_HMI”.

In the “OPERATION_HMI” data block, create the following four tags of data type BOOL: “Mode selection”, “Automatic_Start”, “Automatic_Stop” and “Reset.Counter_Plastic”. The start value of the “Automatic_Stop” tag is preset with “true”.
The "MOTOR_AUTO[FB1]" function block is now expanded to include an input tag "Reset_Workpiece_Counter_Plastic" of type "Bool". This tag is moved onto the "R" input of the "CTUD" counter in network 2 using drag-and-drop.

The call of the function block "MOTOR_AUTO[FB1]" must be updated in the "Main[OB1]" block. This is done by clicking the icon "Update inconsistent block calls".
→ In network 3 of the "Main[OB1]" block, drag an "OR" in front of the input tag "Start_command".

→ The second free input of the "OR" is connected to the "Automatic_Start" tag from the "OPERATION_HMI" data block.
→ In network 3 of the "Main[OB1]" block, drag an → "AND" in front of the input tag → "Stop_command".

The second free input of the → "AND" is connected to the → "Automatic_Stop" tag from the "OPERATION_HMI" data block.
→ The input tag "Automatic_mode_active" is connected to the "Mode selection" tag from the "OPERATION_HMI" data block.

→ The input tag "Reset_part_counter_plastic" is connected to the "Reset_counter_plastic" tag from the "OPERATION_HMI" data block.

→ Compile the CPU again and save the project.

   (→ CPU_1516F → Save project)

→ You download the modified program including the hardware configuration to the CPU 1516F. (→ )
In order to implement a pushbutton that resets the workpiece counter for the plastic parts, use drag-and-drop to move the "Button" object from "Elements" in "Tools" to a location below the plastic parts storage.

Under "General" in "Properties", enter "Reset" as the label.

Under "Appearance" in "Properties", change the "Color" of the "Background" to "Blue".
The functionality must now be configured as a pushbutton. For this, change to the
"Events" menu, select "Press" as the event and "<Add function>".

Under "System functions", select "Bit processing" as the function and select "SetBitWhileButtonPressed" there.
→ For the process connection, select the "Program blocks" of the "CPU_1516F" and the "OPERATION_HMI[DB4]" data block there. Then drag the "Reset_counter_plastic" tag from the "Detail view" into the field for "Tag (input/output)".
→ As shown previously in the document, now insert a text "Plastic parts counter" above the button and a display of the "Plastic_parts_actual" tag from the "MAGAZINE_PLASTIC[DB3]" block to the left of the button.

→ In order to implement the pushbutton, use drag-and-drop to move the "Button" object from "Elements" in "Tools" to a location at the top next to the button for the screen change.
→ Under "General" in "Properties", change the "Mode" to → "Graphics and text". To do this, open the selection dialog for → "Graphic when button is not pressed" by clicking the icon.

Then click the icon for "Create graphic from file" and select the "PushButton-Round-G_Off_256c.bmp" file from the "SCE_EN_042-201_Screens" folder by double-clicking it.
In exactly the same way, select the "Pushbutton-Round-G_On_256c.bmp" file from the "SCE_EN_042-201_Screens" folder for the "Graphic when button is pressed".

Note: The generated graphics are stored in the "Languages & Resources" path under "Project graphics".

Under "Layout" in "Properties", adapt the size of the button under → Position & Size.
The pushbutton functionality is realized here again as event → "Press" with "System function" → "SetBitWhileButtonPressed". The → "Automatic_Start" tag from the data block → "OPERATION_HMI[DB4]" is used for the process connection.

As shown in the last steps, a "button" for the Stop button is inserted. The files "Pushbutton-Stop_Off_256c.bmp" and "Pushbutton-Stop_On_256c" from the "SCE_EN_042-201_Screens" folder are used as graphics.
The functionality as a normally-closed switch is implemented with two events. The first event is "Press" with "System function" → "ResetBit" and the second event → "Release" with "System function" → "SetBit". The "Automatic_Stop" tag from the data block "OPERATION_HMI[DB4]" is used for the process connection in both cases.
In order to implement the mode switch, use drag-and-drop to move the "Switch" object from "Elements" in "Tools" to a location at the top between the buttons for the screen change and the Start button.

Under "General" in "Properties", select the "Show label" option. Next, enter the texts "Auto" for the "ON" state and "Manual" for the "OFF" state. The "Mode selection" tag from the data block "OPERATION_HMI[DB4]" is used for the process connection.
→ Under "Layout" in "Properties", adapt the size of the mode switch under →Position & Size.

→ Now compile the CPU and save the project.

( → Panel TP700 Comfort → Save project)

→ Afterwards, download the changed visualization to the panel.

( → )
7.14 Adapting the headers in the template

→ The plant states are to be shown overall in the header. “Template_1” for our header and footer was already created by the wizard when the panel was created. The footer contains the system buttons and a logo, date and time as well as the “Screen title” text field was previously created in the header.

→ You would now like to adapt the screen title to the dimensions specified here under “Layout” in “Properties” in → “Position & Size”.

→ Delete the logo on the left in the header by selecting the graphic display for the LOGO with the right mouse button and clicking “Delete”.

For unrestricted use in educational and R&D institutions. © Siemens AG 2017. All rights reserved.
→ In the "Panel TP700 Comfort", open the → "Text and Graphic lists" folder.

→ Under "Graphic lists", create a → "Graphic_List_Warning" with → selection "Bit(0,1)".
→ Click the icon for "Value 0" to open the selection dialog for the graphics stored under "Project graphics" in the "Language & Resources" path. Click the icon for "Create graphic from file" and select the "Warning.bmp" file from the "SCE_EN_042-201_Screens" folder by double-clicking it. This file is stored in the "Languages & Resources" path under "Project graphics".

![Image of the Graphic lists and Graphic list entries](image-url)
→ The graphic that you want to assign to "Value 1" is already stored in the "Languages & Resources" path under "Project graphics". After clicking the ➤ icon, you can select the ➤ "Logo of Panel TP700 Comfort" file directly.

→ Now change to the “Text lists” and create the following three text lists: ➤ "Text list_Emergency stop" ➤ "Text list_Main switch" and ➤ "Text list_Automatic". Use the ➤ selection “Bit(0,1)” in each case.
→ Make the following assignments in “Text list_Emergency stop”: “Value 0” → “EMERGENCY STOP triggered” and → “Value 1” → “EMERGENCY STOP OK”.

→ Make the desired assignments in “Text list_Main switch”: “Value 0” → "Main switch OFF" and → "Value 1" → "Main switch ON".

→ Make the following assignments in “Text list_Automatic”: "Value 0" → "Automatic stopped" and → "Value 1" → "Automatic started".
→ Back in "Template_1" for our header, use drag-and-drop to move the "Graphic IO field" object from "Elements" in Tools to the top left corner.

→ Under "General" in "Properties", change the "Mode" to "Output". Then open the selection dialog for "Graphic list" by clicking the icon. Select the "Graphic list_Warning" you just created.
→ To establish the connection to the global tag in the CPU, select "PLC tags" under "CPU_1516F" and below that "Tag_table_sorting_station". Now drag the "A1" tag from the "Detail view" into the "Tag" field. In addition, select "Bit number 0" as the type of evaluation.

→ Under "Layout" in "Properties", adapt the size of the "Graphic IO field" under "Position & Size".
To display the status of the EMERGENCY STOP in the header, use drag-and-drop to move the "Symbolic IO field" object from "Elements" in Tools to the right of the "Graphic IO field".

Under "General" in "Properties", change the "Mode" to "Output". Next, open the selection dialog for "Text list" by clicking the icon. Select the "Text list_Emergency stop" you just created.
To establish the connection to the global tag in the CPU, select "PLC tags" under "CPU_1516F" and below that "Tag_table_sorting_station". Now drag the "-A1" tag from the "Detail view" into the "Tag" field and also select "Bit number 0" under "Layout" in "Properties", adapt the size of the "Graphic IO field" under "Position & Size".

- Under "Layout" in "Properties", adapt the size of the "Graphic IO field" under "Position & Size".

→ Repeat the preceding steps again for the text lists “Text list_Main switch” and “Text list_Automatic” to insert these left of the date and time directly one beneath the other.

→ The “Text list_Main switch” is connected using the “-K0” tag from Tag_table_sorting_station.

→ The “Text list_Automatic” is connected using the “-Memory_Automatic_Start_Stop” tag from “MOTOR_AUTO_DB1[DB1]”.

→ Under “Appearance” in “Properties”, change the “Color” of the “Background” for “Text list_Main switch” and “Text list_Automatic” to “Gray”.
→ For → "Text list_Main switch" and → "Text list_Automatic", change to the "Animation" tab and select "Display" and click → "Add new animation".

![Animation settings dialog](image)

→ In the displayed dialog, select → "Appearance" and click → "OK".

![Animation appearance settings](image)

→ In "Appearance" of both "Symbolic IO fields", add an area with the value → "1" (signal state "High") and change the "Background color" to → "Green".

![Symbolic IO field settings](image)
→ The "Text list_Main switch" is connected using the "-K0" tag from Tag_table_sorting_station.

→ The "Text list_Automatic" is connected using the "-Memory_Automatic_Start_Stop" tag from "MOTOR_AUTO_DB1[DB1]".
In the default tag table, the "Acquisition cycle" of all tags is also to be accelerated from 1 second to 100 milliseconds here.

Before the project is downloaded to the CPU and the panel, compile the CPU and panel again and save the project. (CPU_1516F → Panel TP700 Comfort → Save project)

After successful compilation, the complete controller with the created program including the hardware configuration can be downloaded, as described in the previous modules.

To download the visualization to the panel, proceed in a similar way. Select the "Panel TP700 Comfort [TP700 Comfort]" folder and click the icon "Download to device".
7.15 Bar graph

→ You would like to specify the setpoint for the speed control of the motor and display the actual value. To do this, open the "SPEED MOTOR" screen by double-clicking it.

→ The text field in the center of the screen is to be removed by right-clicking it and selecting "Delete" in the displayed dialog.
In order to graphically display the actual speed value, use drag-and-drop to move the "Bar" object from "Elements" in "Tools" to the center of the screen.

Under "General" in "Properties", change the "Maximum scale value" to 50 and the "Minimum scale value" to -50.
For the process connection, select the "Program blocks" of the "CPU_1516F" and the "SPEED_MOTOR[DB2]" data block there. Then drag the "Actual speed value" tag from the "Detail view" into the field for "Process tag".


Under "Layout" in "Properties", adapt the position and size of the bar under "Position & Size". Above the bar diagram, insert a "Text field" for the description with text "Actual speed value".
In order to specify the speed setpoint, move the “IO field” object from “Elements” in “Tools” to a location above and to the right of the bar display.

Under “General” in “Properties” keep the “Type” as “Input/Output” and change the “Format pattern” to “s99.99.”
→ For the process connection, select the "Program blocks" of the "CPU_1516F" and the "SPEED_MOTOR[DB2]" data block there.

Now drag the "Speed setpoint" tag from the "Detail view" into the field for "Tag".

→ Under "Appearance" in "Properties", change the "Color" of the "Background" to "Blue".
→ Under “Text format” in "Properties", change the “Horizontal” setting of "Alignment" to “Right”.

→ Under "Layout" in "Properties", adapt the position and size of the IO field under "Position & Size".

→ Above the bar diagram, insert a text field for the description with text “Speed setpoint”.

---

For unrestricted use in educational and R&D institutions. © Siemens AG 2017. All rights reserved.
In the default tag table, the "Acquisition cycle" of the newly created "SPEED_MOTOR_speed setpoint" tag is again changed from 1 second to 100 milliseconds.

Before the visualization is downloaded to the panel, compile the panel again and save the project.

(Panel TP700 Comfort → Save project)

Select the "Panel TP700 Comfort [TP700 Comfort]" folder and click the icon "Download to device".

### 7.16 Alarms

When you created the TP700 Comfort Panel using the wizard, you created a pair of alarm windows at the same time. You should now look these over in more detail.

#### 7.16.1 General alarm settings

You first want to make a pair of settings for the display of alarms in Runtime. To do this, double-click the "Runtime settings" folder in "Panel TP700 Comfort" to select it. Under "General" in "Alarms", select "Colors of alarm classes". Under "System events", change display duration in seconds to "10". Under "Controller alarms", check whether the "System diagnostics" check box is selected.
7.16.2 Alarm window

→ In order for the alarm window to be shown in the foreground in every screen, there is a → “Global screen” in the → “Screen management” folder in → “Panel TP700 Comfort”. Open this with a double-click. An alarm window → “System events” has already been created in this screen. Under “General” in “Properties”, ✔ “Pending alarms” of ✔ “System” alarm class are already activated.

→ System events will thus automatically be displayed for ten seconds in Runtime.
→ As a second alarm window in the "Global screen" there is → "Pending alarms". Under "General" in "Properties", activate ✓ "Pending alarms" and ✓ "Unacknowledged alarms". Activate ✓ "Errors", ✓ "Warnings" and ✓ "No Acknowledgment" as alarm classes.

**Note:** You will create alarm classes of types "Errors" and "Warnings" in the panel itself in the following steps. The alarm class of the "No acknowledgment" type is produced automatically by the settings for the system diagnostics in the CPU 1516F.

→ Under "Miscellaneous" in "Properties", change the "Name" to → "Alarm window_pending_not_acknowledged".

→ Under "Mode" in "Properties", change the "Title" to → "Pending/not acknowledged alarms".
### 7.16.3 Alarm indicator

In addition to the alarm windows there is an "Alarm indicator" in the "Global screen". This is used so that an alarm window that was closed by the user is displayed again. Under "General" in "Properties", activate the alarm classes "Errors: Pending alarms", "Errors: Acknowledged", "Warnings: Pending alarms" and "No Acknowledgment: Pending alarms".

In "Events", the display of the alarm window "Alarm window_pending_not_acknowledged" with function "ShowMessageWindow" has already been stored for "Click" and "Click when flashing".
7.16.4 Alarms for system diagnostics of CPU 1516F

→ Open the "Device configuration" of the "CPU_1516F" and select the → "System diagnostics" menu under → "General" in → "Properties".

System diagnostics is always activated for devices of the SIMATIC S7-1500 series.

Under → "Alarm setting", you see which alarm classes are being used. Here, the alarm class is "No Acknowledgment". These alarm classes are referenced in turn by the HMI systems in the alarm windows and for the other settings for the alarms.

→ Select the analog output module → "AQ4xU/I" and activate → "Diagnostics" → "Missing voltage supply L+" for all channels under → "Outputs" in → Properties.
Before the project is downloaded to the CPU and the panel, compile the CPU and panel again and save the project.

(→ CPU_1516F → Panel TP700 Comfort → Save project)

After successful compilation, the complete controller with the created program including the hardware configuration can be downloaded, as described in the previous modules.

(→ CPU_1516F)

To download the visualization to the panel, proceed in a similar way. Select the → "Panel TP700 Comfort [TP700 Comfort]" folder and click the icon → "Download to device".

Alarms for system diagnostics of the CPU 1516F are now automatically displayed in the alarm window "Pending/Unacknowledged alarms". Details and help texts can be displayed and alarms can be acknowledged if necessary in this alarm window. If the alarm window has been closed, it can be displayed again by clicking the displayed alarm indicator. This example shows a failure of the supply voltage for the "AQ4xU/I" module.
7.16.5 Alarm class settings

The item "HMI alarms" is available in the "Panel TP700 Comfort" for configuring the alarm system and creating individual alarms. Open this with a double-click. The alarm classes we are using have already been created in the menu command "Alarm classes" but these can also be changed. For alarm class "Warnings", change the background color for the "Incoming" and "Outgoing" states to "Yellow".
7.16.6 System events

→ With the menu command "System events", you can have these automatically imported by clicking → "Yes".

7.16.7 Controller alarms

→ The controller alarms have already been created with the menu command "Controller alarms".
7.16.8 Analog alarms

You can monitor tags to determine whether they are within limits in "Analog alarms".

Create a new alarm by clicking "Add". For monitoring purposes, select the "Default tag table" in "Panel TP700 Comfort" and drag the "SPEED_MOTOR_actual_speed_value" tag that is to be monitored from the "Detail view" into the field for "Trigger tag". Drag the variable limit "SPEED_MOTOR_positive_speed_error_limit" from the "Detail view" into the field for "Limit".

Enter the text "Error limit exceeded positive motor speed", select the "Alarm class" "Errors" and "Mode" "High". Create the three other alarms of alarm classes "Warnings" and "Errors" shown below in the same way.
Discrete alarms

Before you can create discrete alarms in the panel, you need a global tag with at least 16 bits in the CPU 1516F. You will use this tag to trigger the discrete alarms from the PLC. In "CPU 1516F", open the data block → "OPERATION_HMI[DB4]" in the "Program blocks" folder and create a global tag → "Group alarms 01" of data type → "Word" there.

In the "Program blocks" folder, click → "Add new block" to create → "Discrete alarm_assignment".
In the "Discrete alarm_assignment" function, create a local input tag "DiscreteAlarmX0" of data type "Bool" and a local output tag "GroupAlarms01" of data type "Word". In the first network, program a single 1:1 assignment of the "DiscreteAlarmX0" tag to Bit X0 in the "GroupAlarms01" tag.

**Note:** The "Tag1.%X0" syntax is referred to as **Slice** access in the TIA Portal. This enables access to the individual bits of a tag of data type Byte, Word or DWord: If you need additional information about this, search for the term "Slice" in the online help for STEP 7 Professional V13.
Open the "Main[OB1]" block from the "Program blocks" folder and call the "Discrete_alarm_assignment[FC1]" function in "Network 4". Connect the input of the "Discrete_alarm_assignment[FC1]" function to the inverted global tag "-K0" / %I0.1 / Station "ON"(no) from the "Tag_table_sorting_station". Connect the output of the "Discrete_alarm_assignment[FC1]" function to the global tag "GroupAlarms01" from the data block "OPERATION_HMI[DB4]".
→ Return to → "HMI alarms" → "Discrete alarms" in the "Panel TP700 Comfort". Create a new alarm by clicking → "Add". Select the → "GroupAlarms01" tag you just created from the "OPERATION_HMI[DB4] data block as the "Trigger tag". Enter the text → "Main switch OFF" in the "Alarm text" column, select the "Alarm class" → "Warnings" and "Trigger bit" → "0". In the "Trigger address" column, "OPERATION_HMI.GroupAlarms01.x0" is now displayed.
The alarm display is also adapted in "Template_1" in the "Screen management" folder. Under "General" in "Properties", activate "Pending alarms". Activate "Errors", "Warnings" and "No Acknowledgment" as alarm classes.

Under "Miscellaneous" in "Properties", change the "Name" to "Alarm line".
→ Before the project is downloaded to the CPU and the panel, compile the CPU and panel again and save the project.

(→ CPU_1516F → Panel TP700 Comfort →

→ After successful compilation, the complete controller with the created program including the hardware configuration can be downloaded, as described in the previous modules.

(→ CPU_1516F →)

→ To download the visualization to the panel, proceed in a similar way. Select the "Panel TP700 Comfort [TP700 Comfort]" folder and click the icon "Download to device".

→ Analog alarms and discrete alarms for system are now automatically displayed in the alarm window "Pending/Unacknowledged alarms" and in the "Alarm line". Details and help texts can be displayed and alarms can be acknowledged if necessary in the alarm window. If the alarm window has been closed, it can be displayed again by clicking the displayed alarm indicator. Various alarm classes appear in different colors.
7.17 Remote control of the TP700 Comfort Panel

7.17.1 Activating web services for Runtime

To enable remote control, double-click the “Runtime settings” in the configuration for the Panel TP700 Comfort to open them. The “Start Sm@rtServer” option is activated for “Layout” under “Remote control” and the “HTML pages” option is activated under “Diagnostics”.

7.17.2 WinCC Internet settings in the TP700 Comfort Panel

Settings must also be made directly on the panel. Select "Settings" in the "Start Center" directly after switching on the voltage supply and the start of the panel.

Note: The selection of "Settings" must occur fast enough, and before the automatic "Start" of Runtime.
Select from the icons in order to make the web server settings.

With menu command "Web Server", first select the “Start automatically after booting" option and click on "User Administration".
→ Assign the administrator password in the "Password" field → "100", confirm it in the "Confirm Password" field → "100" and apply it with → "Apply".

→ With menu command "Remote", first select the "Start automatically after booting" option and click → "Change settings".

→ Also assign → "100" for Password1 and → "100" for Password2 and put this into effect with → "Apply".
7.17.3 Starting remote access to the TP700 Comfort Panel

→ To start the remote access to your panel, enter the IP address of the in your browser → “192.168.0.10”.

Note: A current installation of Java Runtime Environment is required for secure access to the web services of the TP700 Comfort Panel.

→ Enter the password that was previously set in the panel → "100".
You then have the option of monitoring, and operating the panel remotely and even changing the settings in Windows CE of the device.
7.18 Archiving the project

As the final step, you want to archive the complete project. Select the 'Archive...' command in the 'Project' menu. Open a folder where you want to archive your project and save it with the file type "TIA Portal project archive".

(→ Project → Archive → TIA Portal project archive → SCE_EN_042-201_WinCC
Advanced with TP700 and S7-1500... → Save)
## 8 Checklist

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Program changes successfully performed in the CPU 1516F</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 1516F successfully compiled without error message</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CPU 1516F successfully downloaded without error message</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Process visualization for the Touch Panel TP700 Comfort successfully created</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Touch Panel TP700 Comfort successfully compiled without error message</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Touch Panel TP700 Comfort successfully downloaded without error message</td>
<td></td>
</tr>
</tbody>
</table>
| 7   | Switch on station (-K0 = 1)  
Cylinder retracted/Feedback activated (-B1 = 1)  
EMERGENCY OFF (-A1 = 1) not activated  
AUTOMATIC mode (in the panel)  
Pushbutton automatic stop not actuated (-S2 = 1)  
Briefly press the automatic start pushbutton (in the panel)  
Sensor part at slide activated (-B4 = 1)  
then conveyor motor -M1 variable speed (-Q3 = 1) switches on and remains active  
The speed corresponds to the speed setpoint in the range +/- 50 rpm |          |
| 8   | Sensor part at end of conveyor activated (-B7 = 1) → -Q3 = 0 (after 2 seconds) |          |
| 9   | Briefly press the automatic stop pushbutton (-S2 = 0) → -Q3 = 0              |          |
| 10  | Activate EMERGENCY OFF (-A1 = 0) → -Q3 = 0                                 |          |
| 11  | Manual mode (in the panel) → -Q3 = 0                                       |          |
| 12  | Switch off station (-K0 = 0) → -Q3 = 0                                     |          |
| 13  | Cylinder not retracted (-B1 = 0) → -Q3 = 0                                 |          |
| 14  | Speed > SPEED_MOTOR_monitoring_error_max → -Q3 = 0                         |          |
| 15  | Speed < SPEED_MOTOR_monitoring_error_min → -Q3 = 0                         |          |
| 16  | Values and alarms are displayed in the panel.                               |          |
| 17  | Project successfully archived                                               |          |
9 Exercise

9.1 Task – Exercise

In this exercise, the process visualization is to expanded to include the following functions:

In the "Overview of sorting station" screen, "Set" and "Actual" will now be displayed for the count of "Plastic" workpieces.

In the "Motor Speed" screen, the actual and setpoint speed of the motor will now be displayed graphically and in IO fields. The setpoint speed can also be specified here.

The error and warning limits for the positive and negative motor speed are also to be displayed and can be set in IO fields. Before the IO fields, a small red box indicates when a limit has been exceeded.

In the "Plastic Magazine" screen, "Set" and "Actual" will be displayed graphically and in IO fields. The setpoint for the plastic parts can be specified in the IO field or with a slider in the range of 0 to 20. It is also possible to reset the counter here.

In the Alarm system, the emergency stop and the status of automatic mode are also to be monitored. If the emergency stop is triggered or the automatic mode is stopped, a warning is to be displayed.

9.2 Technology diagram

Here, you see the technology diagram for the task.

![Technology diagram](image1)

![Control panel](image2)
9.3 Reference list

The following signals are required as global operands for this task.

<table>
<thead>
<tr>
<th>DI/DO</th>
<th>Type</th>
<th>Identifier</th>
<th>Function</th>
<th>NC/NO</th>
</tr>
</thead>
<tbody>
<tr>
<td>I 0.0</td>
<td>BOOL</td>
<td>-A1</td>
<td>Return signal emergency stop OK</td>
<td>NC</td>
</tr>
<tr>
<td>I 0.1</td>
<td>BOOL</td>
<td>-K0</td>
<td>Main switch &quot;ON&quot;</td>
<td>NO</td>
</tr>
<tr>
<td>I 0.2</td>
<td>BOOL</td>
<td>-S0</td>
<td>Mode selector manual (0)/ automatic (1)</td>
<td>Manual = 0 Auto = 1</td>
</tr>
<tr>
<td>I 0.3</td>
<td>BOOL</td>
<td>-S1</td>
<td>Pushbutton &quot;Automatic Start&quot;</td>
<td>NO</td>
</tr>
<tr>
<td>I 0.4</td>
<td>BOOL</td>
<td>-S2</td>
<td>Pushbutton &quot;Automatic Stop&quot;</td>
<td>NC</td>
</tr>
<tr>
<td>I 0.5</td>
<td>BOOL</td>
<td>-B1</td>
<td>Sensor cylinder -M4 retracted</td>
<td>NO</td>
</tr>
<tr>
<td>I 1.0</td>
<td>BOOL</td>
<td>-B4</td>
<td>Sensor part at slide</td>
<td>NO</td>
</tr>
<tr>
<td>I 1.3</td>
<td>BOOL</td>
<td>-B7</td>
<td>Sensor part at end of conveyor</td>
<td>NO</td>
</tr>
<tr>
<td>IW64</td>
<td>BOOL</td>
<td>-B8</td>
<td>Sensor actual value speed of the motor +/-10V corresponds to +/- 50 rpm</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DO</th>
<th>Type</th>
<th>Identifier</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q 0.2</td>
<td>BOOL</td>
<td>-Q3</td>
<td>Conveyor motor M1 variable speed</td>
</tr>
<tr>
<td>QW 64</td>
<td>BOOL</td>
<td>-U1</td>
<td>Manipulated value speed of the motor in two directions +/-10V corresponds to +/-50 rpm</td>
</tr>
</tbody>
</table>

Legend for reference list

DI: Digital input       DO: Digital output
AI: Analog input        AO: Analog output
I: Input                O: Output
NC: Normally Closed     NO: NO Normally Open

9.4 Planning

Plan the implementation of the task on your own.
## 9.5 Checklist – Exercise

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Program changes successfully performed in the CPU 1516F</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 1516F successfully compiled without error message</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CPU 1516F successfully downloaded without error message</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Process visualization for the Touch Panel TP700 Comfort successfully created</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Touch Panel TP700 Comfort successfully compiled without error message</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Touch Panel TP700 Comfort successfully downloaded without error message</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Switch on station (-K0 = 1)                                                                                                           Cylinder retracted / Feedback activated (-B1 = 1) EMERGENCY OFF (-A1 = 1) not activated AUTOMATIC mode (in the panel) Pushbutton &quot;Automatic stop&quot; not actuated (-S2 = 1) Briefly press the &quot;Automatic start&quot; pushbutton (in the panel) Sensor part at slide activated (-B4 = 1) then conveyor motor -M1 variable speed (-Q3 = 1) switches on and remains active The speed corresponds to the speed setpoint in the range +/- 50 rpm</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sensor part at end of conveyor activated (-B7 = 1) → -Q3 = 0 (after 2 seconds)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Briefly press the automatic stop pushbutton (-S2 = 0 or in the panel) → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Activate EMERGENCY OFF (-A1 = 0) → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Manual mode (in the panel) → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Switch off station (-K0 = 0) → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Cylinder not retracted (-B1 = 0) → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Speed &gt; SPEED_MOTOR_monitoring_error_max → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Speed &lt; SPEED_MOTOR_monitoring_error_min → -Q3 = 0</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Values and alarms are displayed in the panel.</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Project successfully archived</td>
<td></td>
</tr>
</tbody>
</table>
10 Additional information

You can find additional information as an orientation aid for initial and advanced training, for example, Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software/firmware, at the following link:

www.siemens.com/sce